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Section 1 - Introduction 

1.1 Preface   

1.1.1 Goals 
The CTDOT Digital Design Environment (DDE) is a toolkit that allows for the creation, 
modification, and exchange of high-value digital and electronic engineering data. The 
information and resources contained in the DDE have been developed for use with CTDOT’s 
foundational CAD platforms including OpenX products: OpenRoads Designer, OpenBridge 
Modeler, OpenRail Designer and OpenBuildings Designer by Bentley Systems, Inc. 

The goals of this DDE Guide are: 

• To provide an environment that will enable users of all skill levels to produce 
engineering drawings and documents in accordance with CTDOT standards. 

• To maintain interoperability and collaboration with Consultant Engineers and State 
Design staff. 

• To provide one storage location for all project planning, design and construction 
digital and electronic data. 

• To create high-value digital and electronic data that maintains its attributions well 
into the future and can be used in an interactive decision system. 

• To meet the Governor’s Executive Order No. 3, "All state agencies in the executive 
branch and all higher education agencies and institutions shall post all bids, 
requests for proposals and all resulting contracts and agreements on the State 
Contracting Portal and shall, with the assistance of the Department of Administrative 
Services and the Department of Information Technology as needed, develop the 
infrastructure and capability to electronically communicate with the State 
Contracting Portal." 

• To publish contracts in a common, portable document format (PDF). 

An important term which is becoming more popular within many states' DOTs is High Value 
Data (HVD). HVD is digital and electronic data created as a byproduct of the design 
process. It includes information contained in both 2D and 3D models that can be used 
during the construction phase of the project for terrain queries, optional GPS-driven earth 
moving equipment and in the life cycle maintenance of a designed transportation facility. 
Coming full circle, these files can also be used for any rehabilitation or modification of the 
existing project in the future. Previously, CTDOT has only supplied paper contract drawings 
and specifications to the Contractor and Construction Inspectors. With CTDOT’s project 
container electronic file storage approach, this data is now in place and searchable for 
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future queries. HVD can be used in Business Information Modeling (BIM) and Geographical 
Information Systems (GIS). 

1.1.2 Purpose 
The intent of this guide is to define uniform procedures as well as to explain the structure of 
CTDOT’s DDE. This guide will identify standard resource files, configurations and CAD 
functions used in the creation, management and publishing of digital and electronic 
engineering data. 

This guide does not replace the need for other references and training. Additional 
publications and training may be needed for further clarification of CAD procedures and 
functions. This guide is not intended to prevent or limit individual initiatives and engineering 
judgment used in project design and development. Rather, it is meant to document 
standard digital design procedures in practice at CTDOT. 

Users of this guide include Designers, Planners, Surveyors and CAD Managers that work at 
or with CTDOT staff. The information provided in this guide is subject to revision as updates 
are made to the software and methodology in accordance with CTDOT DDE policies. 

1.1.3 About The Guide 
This Guide is designed for use in Live instructor-led training, and for OnDemand selfstudy.  
This guide will introduce CTDOT users and consultants to Bentley OpenX products. This 
guide assumes users have had previous training on, and a working knowledge of 
OpenRoads Designer, OpenBridge Modeler, OpenRail Designer or OpenBuildings Designer. If 
users have not had training on these software applications, visit the Bentley’s LEARNserver 
Website.  

This guide has been divided into volumes, consisting of information and/or exercises.  
Volume 1 - Getting Started 
Volume 2 - Working with Existing Data 
Volume 3 - OpenRoads Designer Survey 
Volume 4 - OpenRoads Designer Roadway Modeling 
Volume 5 - OpenRoads Designer Drainage and Utility Modeling 
Volume 6 - OpenRoads Designer Traffic Engineering Base Modeling. 
Volume 7 – OpenRoads Designer Roadway Illumination Base Modeling 
Volume 8 - OpenRoads Designer Landscape Base Modeling 
Volume 9 - OpenRoads Designer Boundary Survey 
Volume 10 - OpenRoads Designer Site Layout 
Volume 11 - OpenBridge Modeler 
Volume 12 - Other Applications (OpenBuildings, OpenRail, GuideSign, AutoTurn) 
Volume 13 - Contract Plans Production 
Volume 14 - Printing and Publishing 
Volume 15 - Miscellaneous Workflows 
Volume 16 - Appendix 

https://learn.bentley.com/app/Public
https://learn.bentley.com/app/Public
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1.1.4 Terms 

• the term "design file" refers to OpenX applications (OpenRoads, OpenBridge, 
OpenRail, and OpenBuildings) .dgn file that are built on base MicroStation.  

• the terms "directory, subdirectory, folder and subfolder" will be used interchangeably 
in the text. 

• The terms “Left-click”, “Click”, “Select” and “Data Point” are used interchangeably to 
represent pressing the left mouse button. The terms “Right-click” and “Reset” are 
also used interchangeably to represent pressing the right mouse button. If your 
mouse buttons are assigned differently, such as for left-handed use, you will need to 
adjust accordingly. 

• Hyperlinks are in blue underlined letters 

• Bold Blue indicates a tool or selection button 

• Green Bold Italics indicates a path or input 
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1.2 Help and Support  

1.2.1 AEC CAD Support Ticket 
CTDOT employees and consultants can use this form to request Digital Design Environment 
support from the AEC team: 

CAD Support Ticket 
CTDOT employees will need to email DOT.Helpdesk@ct.gov for: 

• Software installs and licensing 
• Accounting access 
• New user accounts 
• Hard drive or monitor issues 
• Network file backups and permissions 

1.2.2 AEC CAD Support Staff  
The AEC CAD Unit is responsible for the development and maintenance of CTDOT's DDE.   

• Mathew Calkins Mathew.Calkins@ct.gov 
• Elaine Richard Elaine.Richard@ct.gov 
• John Rinaldi John.Rinaldi@ct.gov 
• Yash Manandhar Yash.Manandhar@ct.gov 
• Tushar Gaddi Tushar.Gaddi@ct.gov 
• Alvie Griffith Alvie.Griffith@ct.gov 
• Michael H. Antonio Michael.Antonio@ct.gov 

1.2.3 CTDOT DDE Website and YouTube Page 
Access the CTDOT CONNECT DDE website and DDE Guide can be found on multiple CTDOT 
web pages. 
Digital Project Solutions - AEC Main Page 
 
or Home > Business > Resources > Consultant Resources 
Scroll down to Publications 
Digital design tools and requirements CADD information 
Digital design tools and requirements CADD manual 
 
CTDOT DDE training videos can be found here: 
CTDOT Digital Project Solutions Training Hub - YouTube 

https://ctdotcompass.atlassian.net/servicedesk/customer/portal/8/group/24/create/99
mailto:DOT.Helpdesk@ct.gov
mailto:Mathew.Calkins@ct.gov
mailto:Elaine.Richard@ct.gov
mailto:John.Rinaldi@ct.gov
mailto:Yash.Manandhar@ct.gov
mailto:Tushar.Gaddi@ct.gov
mailto:Alvie.Griffith@ct.gov
mailto:Michael.Antonio@ct.gov
https://portal.ct.gov/dot/engineering-applications/digital-project-solutions---aec-main-page?language=en_US
https://portal.ct.gov/dot/engineering-applications/ctdot---connect-dde
https://portal.ct.gov/dot/engineering-applications/ctdot-dde-guide---bentley-connect-edition
https://www.youtube.com/@ctdotdigitalprojecttraininghub
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1.2.4 CTDOT CAD Training Enrollment 
CTDOT staff should use this form to enroll new employees into the CAD Training Program or 
to revise an enrollment of an existing user. Revisions will need to be submitted when 
employees are promoted or move to a different unit. 
CAD Training Enrollment  

1.2.5 Bentley Services 
This guide is not intended to be the sole source of information for the CONNECT Edition user; 
there are various resources available through Bentley.   

1. Bentley Support Portal - Customer Service 

2. Help Command: CONNECT Edition software has extensive online help available through 
Help in the File menu 

 
Figure 1 OpenX Products Help Menu 

3. Bentley Learning website. 

4. Phone Assistance: Users can call Bentley directly at: 1-800-236-8539 (1-800-BENTLEY) 

1.2.5.1 Bentley Sign in 
A Bentley Select ID is automatically created with your State email address.  Your Bentley ID 
login name is the same as your State email address (Firstname.Lastname@ct.gov). Due to 
Single Sign On, you may not be required to create a password. 

Consultant engineers must purchase their own subscription.  

Bentley Select ID’s allow you to access Bentley Online training, Bentley Community Boards, 
licensing and other support resources.  

1. To log in the first time to Bentley, go to Bentley Cloud Services.  

2. Enter your state email address. Click on “Use another account” if there is another email 
address present. 

https://ctdotcompass.atlassian.net/servicedesk/customer/portal/8/group/24/create/101
https://bentleysystems.service-now.com/csp?id=csp_index
http://www.bentley.com/en-US/Training/
mailto:Firstname.Lastname@ct.gov
https://connect.bentley.com/
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3. You are also able to sign into the CONNECTION Client located in the System tray. Open the 
System tray on the taskbar. Right click on CONNECTION Client icon. Select Open.  Login 
using your state email address and your password.  

 
Figure 2 CONNECTION Client System tray 

1.2.5.2 My Services in the CONNECTION Center 
 

1. On the CONNECTION Client select CONNECT Center… 

 
Figure 3 CONNECT Center Waffle 
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2. Select the Services icon, groups of icons will pop up. One by one select the icons listed 
below and explore what they have to offer. 

Bentley Communities - Use this site's search function to find how-to tips, Bentley 
product support, best practices, opinions and advice from peers and Bentley subject 
matter experts. Gain insight and get answers to a wide range of topics related to Bentley 
products. 

New Case - Service Requests can be created through the Bentley’s Support Portal. 
Select the New Case > Technical Support icons to create a new Request. 

Learn - Choose from live virtual classrooms or on-demand courses. 

 

 
Figure 4 CONNECTION Center My Services 

1.2.5.3 Bentley LEARN Online Training  

After you have Bentley account, browse to https://learning.bentley.com and Sign in with 
your credentials. After signing in you will be connected to the Bentley LEARN.  

The Bentley LEARN is the service offered by Bentley to all Connecticut DOT CAD users.  

Based on your discipline AEC applications will set you up with a specific learning path on 
Bentley LEARN (My Courses & Learning Plans).  

https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2F&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509264668%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=Z9cn6Co6hWNv%2F%2B74iDE0HbyocLa2JgR0MfbYV3SwK9w%3D&reserved=0
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This path can be utilized as reference or as refreshers for Bentley Connect Software’s. Select 
the Learning Plan then select Course to Play. Each course may have dataset which can be 
downloaded for the training. 

Note: Learning Plan has been established for you. (Only a few are assigned as Bentley 
Server takes time to sync your ID from Bentley Connect to Bentley Learn. Direct links are 
provide below) 

 
Figure 5 Bentley Learn Server Play Video 
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Users can update their profile under My Profile and check activities under My Activities. 

 
Figure 6 Bentley Learn Server May Courses and Learning Paths 

Users can also search for Learning Plan or Courses on demand themselves according to 
Preferred Type and Preferred Brand, then clicking on “Search” icon.  Choose the desired 
training from the list and then you can Enroll to that training. 

 
Figure 7 Bentley Learn Server Search 
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Figure 8 Bentley Learn Server Popular Software 

 
Figure 9 Bentley Learn Server Enroll in Course 
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1.2.5.4 Direct Links to Training 
Direct Links to few Learning Plan (You can use these links to get enrolled if you are not 
already) 

For Everyone 
MicroStation for Existing Users 
https://learning.bentley.com/learn/courses/91/quickstart-for-microstation-connect-
edition-for-existing-
users?hash=46624563e28466b4883cb20336fb11b749005bda&generated_by=45780 
MicroStation for New Users :  
https://learning.bentley.com/learn/learning-plans/348/microstation-for-new-
users?hash=bc467d20b3bf02d0344d6ab8d91f01bcc2140bb1&generated_by=45780 

 

For Highway Design 
00 - Roadway Design Modeling – Fundamentals : 
https://learning.bentley.com/learn/learning-plans/614/00-roadway-design-modeling-
fundamentals?hash=fc3d1a8e9ea60c5d1db7ed7c19149dfc69084002&generated_by=457
80 
01 - Roadway Design & Modeling - Intermediate 
https://learning.bentley.com/learn/learning-plans/617/01-roadway-design-modeling-
intermediate?hash=f82f65491cffb1d904810c0dc76ecfc43de13b49&generated_by=45780 
09 - Drainage Modeling 
https://learning.bentley.com/learn/learning-plans/611/09-drainage-
modeling?hash=85f95b568c0df281ea251e086c467cc275fc8310&generated_by=45780 
10 - Drainage Hydraulics 
https://learning.bentley.com/learn/learning-plans/552/10-drainage-
hydraulics?hash=5bf53d73f2c37d4646f1937dcaa427098fdc98f8&generated_by=45780 

 

For Bridge Design 
Introduction to OpenBridge Designer/OpenBridge Modeler 
https://learning.bentley.com/learn/learning-plans/383/introduction-to-openbridge-
designeropenbridge-
modeler?hash=aea67528666c741788194907afe9f2f40dc575fc&generated_by=45780 

https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Fcourses%2F91%2Fquickstart-for-microstation-connect-edition-for-existing-users%3Fhash%3D46624563e28466b4883cb20336fb11b749005bda%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509280455%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=wkhyP47xyawoVCqbS3tCA7b7cCvAQiFWVZuLlpFXvBA%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Fcourses%2F91%2Fquickstart-for-microstation-connect-edition-for-existing-users%3Fhash%3D46624563e28466b4883cb20336fb11b749005bda%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509280455%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=wkhyP47xyawoVCqbS3tCA7b7cCvAQiFWVZuLlpFXvBA%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Fcourses%2F91%2Fquickstart-for-microstation-connect-edition-for-existing-users%3Fhash%3D46624563e28466b4883cb20336fb11b749005bda%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509280455%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=wkhyP47xyawoVCqbS3tCA7b7cCvAQiFWVZuLlpFXvBA%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Flearning-plans%2F348%2Fmicrostation-for-new-users%3Fhash%3Dbc467d20b3bf02d0344d6ab8d91f01bcc2140bb1%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509296781%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=n72pfIlqqbMbYpYIgMMv%2FlBHmI1bfp58ny%2BCFHwIkE0%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Flearning-plans%2F348%2Fmicrostation-for-new-users%3Fhash%3Dbc467d20b3bf02d0344d6ab8d91f01bcc2140bb1%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509296781%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=n72pfIlqqbMbYpYIgMMv%2FlBHmI1bfp58ny%2BCFHwIkE0%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Flearning-plans%2F614%2F00-roadway-design-modeling-fundamentals%3Fhash%3Dfc3d1a8e9ea60c5d1db7ed7c19149dfc69084002%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509312904%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=Anus%2Bxm7TJmoHDHxPGhbeGqKnrNZCrGMWQeNT1iTI0M%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Flearning-plans%2F614%2F00-roadway-design-modeling-fundamentals%3Fhash%3Dfc3d1a8e9ea60c5d1db7ed7c19149dfc69084002%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509312904%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=Anus%2Bxm7TJmoHDHxPGhbeGqKnrNZCrGMWQeNT1iTI0M%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Flearning-plans%2F614%2F00-roadway-design-modeling-fundamentals%3Fhash%3Dfc3d1a8e9ea60c5d1db7ed7c19149dfc69084002%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509312904%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=Anus%2Bxm7TJmoHDHxPGhbeGqKnrNZCrGMWQeNT1iTI0M%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Flearning-plans%2F617%2F01-roadway-design-modeling-intermediate%3Fhash%3Df82f65491cffb1d904810c0dc76ecfc43de13b49%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509329277%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=UwMhrQZpdZNGdDCZqbqk4xw%2B6MZz3m0U%2FfgQh3FhSG8%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Flearning-plans%2F617%2F01-roadway-design-modeling-intermediate%3Fhash%3Df82f65491cffb1d904810c0dc76ecfc43de13b49%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509329277%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=UwMhrQZpdZNGdDCZqbqk4xw%2B6MZz3m0U%2FfgQh3FhSG8%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Flearning-plans%2F611%2F09-drainage-modeling%3Fhash%3D85f95b568c0df281ea251e086c467cc275fc8310%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509344355%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=%2B5eR193J5spsn6MnQF2hvWB1YNALXyaVZ%2BCQTZ3F6gU%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Flearning-plans%2F611%2F09-drainage-modeling%3Fhash%3D85f95b568c0df281ea251e086c467cc275fc8310%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509344355%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=%2B5eR193J5spsn6MnQF2hvWB1YNALXyaVZ%2BCQTZ3F6gU%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Flearning-plans%2F552%2F10-drainage-hydraulics%3Fhash%3D5bf53d73f2c37d4646f1937dcaa427098fdc98f8%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509359056%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=alCirXCRBgl39AAYa%2BVD9kwdeWCtddnfGReybqmoGmY%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Flearning-plans%2F552%2F10-drainage-hydraulics%3Fhash%3D5bf53d73f2c37d4646f1937dcaa427098fdc98f8%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509359056%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=alCirXCRBgl39AAYa%2BVD9kwdeWCtddnfGReybqmoGmY%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Flearning-plans%2F383%2Fintroduction-to-openbridge-designeropenbridge-modeler%3Fhash%3Daea67528666c741788194907afe9f2f40dc575fc%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509377538%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=E7EV76U1x5Vz2yJgRoaXEfwJ4AcH5XSa2f%2FZig36gk0%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Flearning-plans%2F383%2Fintroduction-to-openbridge-designeropenbridge-modeler%3Fhash%3Daea67528666c741788194907afe9f2f40dc575fc%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509377538%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=E7EV76U1x5Vz2yJgRoaXEfwJ4AcH5XSa2f%2FZig36gk0%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flearning.bentley.com%2Flearn%2Flearning-plans%2F383%2Fintroduction-to-openbridge-designeropenbridge-modeler%3Fhash%3Daea67528666c741788194907afe9f2f40dc575fc%26generated_by%3D45780&data=05%7C02%7CElaine.Richard%40ct.gov%7Cf5ee1a60a4d34d3a38c808dcf84da09c%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638658259509377538%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=E7EV76U1x5Vz2yJgRoaXEfwJ4AcH5XSa2f%2FZig36gk0%3D&reserved=0
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1.3 Model-Centric Design 
CTDOT is standardizing on producing model-centric designs. This will allow for increased 
productivity and adherence to FHWA Every Day Counts (EDC) Innovations and Building 
Information Modeling for Infrastructure also known as BIM for Infrastructure or BIMFi. 

Industry trends across the world using BIMFi include: 
• Mobile Field Inspection and Data Collection 
• AMG (Automated Machine Guidance) 
• GPS Construction Layout 
• eConstruction 
• GIS and Asset Management 

The “I“ in BIMFi is one of the most important aspects of the technology. CONNECT Edition 
products will allow designers to produce a product that retains the business data (the “I” in 
BIMFi) by assigning Item Types placed on CAD Graphics. This data, also known as Electronic 
Engineering Data (EED), can be consumed further downstream during Design Reviews then to 
Construction, Asset Management and Maintenance.  
 
When producing model-centric designs it is extremely important that model types be used as 
intended. A Design Model Type will be used for all Base Models. 
Base Models will: 
• be geospatial 
• contain cells, shapes, and lines that 

represent the physical design 
elements 

• include Item Type information on cells, 
shapes and lines. 

 

Base Models will not have: 
• Border Cells 
• call outs 
• notes 
• tables 
• dimensions 
 

Each Model Type is represented by a different Icon on the Models Dialog Box. 

 
Figure 10 Model Types 

The two other types of models will be used in downstream processes as described in VOLUME 13 - 
CONTRACT PLANS PRODUCTION 

• Drawing Model — Contains annotations, dimensions and callouts. 
• Sheet Model — Contains a Border Cell, Sheet Boundary (plotting shape). 
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Section 2 - DDE Set Up 

2.1  CTDOT Employee Sync 
This workflow will instruct CTDOT Employees on how to set up the CTDOT CONNECT DDE for use 
with OpenRoads Designer, OpenBridge Modeler, and OpenBuildings Designer within the 
Compass/SharePoint environment. 
Users will sync from both their personal location and the State of Connecticut Enterprise 
location. 
After syncing two icons will appear in Windows Explorer: 
• The blue cloud labeled OneDrive - State of Connecticut (OneDrive - <Tenant>) contains 

files and folders synced from the user’s personal OneDrive on the State of Connecticut 
Office 365 Tenant. No one can see or access these files unless the user specifically shares 
them with others. 

 
Figure 11 OneDrive Icon 

• The blue building labeled State of Connecticut contains data synced from the tenant 
outside of the user's personal space. This includes COMPASS projects and other SharePoint 
sites. Access is given through site permissions set up by the SharePoint site admin. 

 
Figure 12 Enterprise Icon 

Before beginning the workflow, please ensure one of the needed CONNECT Edition applications 
have been installed. The CTDOT CONNECT DDE is configured to work with: 

• OpenRoads Designer® (ORD)  
• OpenBridge Designer® (OBM)  
• OpenBuildings Designer® (OBD)  

All products contain the functionality of MicroStation CONNECT Edition along with added 
specific design capabilities. CTDOT will not support the use of plain MicroStation CONNECT 
Edition with our standard configuration files as only OpenRoads Designer, OpenBridge 
Modeler, OpenRail Designer and OpenBuildings Designer align with the BIM functionality 
needed to move design data through its lifecycle. 

Based on your unit, you will need one of the above applications installed. If the needed 
applications are not installed, you will need to contact the DOT Help Desk via email 
at DOT.Helpdesk@ct.gov. 

mailto:DOT.Helpdesk@ct.gov
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2.1.1 Syncing the SharePoint DDE 
1. This instructional video will demonstrate how to sync the SharePoint DDE. 

 

Figure 13 Video Syncing the SharePoint DDE 

2. Verify Install, open File Explorer and verify the State of Connecticut\DOT CTDOT_DDE – 
CONNECT location is now synced. 

 
Figure 14 CTDOT DDE Location 

https://www.youtube.com/embed/SpPRMU-fcyk?start=1&feature=oembed
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2.1.2 Requesting a CAD Project in COMPASS 

1. In File Explorer browse to: 

 …State of Connecticut\DOT CTDOT_DDE - CONNECT\CT_CompassProjects 

Search for your project number. If you do not see your project’s corresponding *.cfg file, 
you will need to request one via this procedure. 

2. Project Engineers will need to request a CAD setup for new projects stored in COMPASS 
using the link below.  This will enable AEC Applications to properly configure the 
COMPASS Project's Design Folder and Discipline Subfolders.  

New CAD Workset Request - CAD Support Portal - Jira Service Management 

3. AEC Applications will set up the WorkSet and the CTDOT Property Fields with the 
information initially provided in the request.  

• CTDOT Project Description 
• CTDOT Project Number 
• CTDOT Town(s) 

The CTDOT Property Fields can be updated by anyone working on the project at any 
time as needed.  On the Splash Screen before opening a DGN file select Properties > 
Advanced Properties.  In the Edit WorkSet dialog box update the CTDOT Property 
Fields as required.  The Contract Border Cell Title Block placed in Sheets Models are 
linked to these Property Fields. 

  
Figure 15 CTDOT DDE WorkSet Properties 

https://ctdotcompass.atlassian.net/servicedesk/customer/portal/8/group/24/create/100
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2.1.3 Syncing a COMPASS Project 
1. Follow the link below to view an instructional video on how to sync a COMPASS Project.   

 
Figure 16 Syncing a COMPASS Project 

2. Verify Install, Open File Explorer and verify the needed Project is Synced under State of 
Connecticut\XXXX-XXXX - Design  

2.1.4 Creating a Non-Projects CAD Work Area 
1. The video above also includes instructions on how to sync a Non-Project working 

Area.  Go to time 1:25. 
2. Verify Install 

Open File Explorer and you will now see the OneDrive - State of Connecticut is now 
synced. 
C:\Users\username\OneDrive - State of Connecticut\CAD_NonProjects\Design  
You can store DGN files and work under the Design folder or browse out to any other 
synced SharePoint site.  For non-project work Reference files should all be in the same 
folder. 

 
 

https://www.youtube.com/embed/2IsPcyDCs6I?start=5&feature=oembed
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2.1.5 CAD Accounting – Application Launcher 
The CTDOT Accounting application is a launcher used to access OpenRoads, 
OpenBridge and OpenBuildings CONNECT Edition products. This application is 
only for CTDOT employees. Command line variables point to SharePoint 
folders for each application to ensure proper configuration for internal use. A 
database of active project coding numbers is maintained by CORE and 
displayed in the launcher. 

 
The user is required to select 
the appropriate Account number (CORE 
number) and Run Program. The Start button 
launches your chosen Bentley product and 
starts a timer that records the elapsed time 
you spend within the selected application. 
Every month, the recorded times are 
compiled across all CAD users for a given 
project. The associated projects are then 
journal vouchered for the elapsed time 
multiplied by the CAD Rate. 
The CAD Rate is a cost per hour for using 
software applications supported by AEC 
Applications. This rate is derived annually by 
the total expenditures to support all 
applications mentioned in the CTDOT’s 
Accounting Process. The expenditures are 
then divided by the total hours spent working 
on projects for that year. The CAD Rate may 
be adjusted for any additional expenditures 
or revenues, including: 

• Software Licensing 
• Software Maintenance 
• Personal Services 
• Software Support 
• Training 
• Hardware 
• Plotting 
• Others 

Figure 18 CAD Accounting Menu 

Figure 17 CAD 
Accounting Icon 
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2.2 Consultant Sync 
This workflow will instruct Consultants/CTDOT Partners on how to set up the CTDOT CONNECT 
DDE in order to use OpenRoads Designer, OpenBridge Design/Modeler, OpenRail Designer, and 
OpenBuildings Designer within the SharePoint/COMPASS Environment. This is the first option 
outside parties can utilize to access the CTDOT DDE. If they are unable or do not wish to Sync to 
the DDE SharePoint site they can use the install method 2.3 Consultant Install. 

Users will sync from both their personal location and the State of Connecticut Enterprise 
location. 
After syncing two icons will appear in Windows Explorer: 
 
The blue building labeled State of Connecticut contains data synced from the tenant outside 
of the user's personal space. This includes COMPASS projects and other SharePoint sites. 
Access is given through site permissions set up by the SharePoint site admin. 

 
Figure 19 Enterprise Icon 

Before continuing, please ensure one of the relevant CONNECT Edition applications have been 
installed. The CTDOT CONNECT DDE is configured to work with: 

• OpenRoads Designer®  
• OpenBridge Modeler® or OpenBridge Designer®  
• OpenRail Designer® 
• OpenBuildings Designer®  

All products contain the functionality of MicroStation CONNECT Edition along with added 
specific design capabilities. Note that OpenBridge Modeler is the CAD component of 
OpenBridge Designer. CTDOT does not support the use of plain MicroStation CONNECT Edition 
with our standard configuration files as only OpenRoads Designer, OpenBridge Modeler, 
OpenRail Designer, and OpenBuildings Designer align with the BIM functionality needed to 
move design data through its lifecycle. 
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2.2.1 Video - Syncing the SharePoint Digital Design Environment 
This video describes how to obtain access to CTCOT’s DDE SharePoint site, how to sync the 
site and how to set up custom Icons. 

 

Figure 20 Video Syncing the SharePoint Digital Design Environment 

2.2.2 Obtaining Access to SharePoint 
Companies must first be whitelisted in CTDOT’s SharePoint/COMPASS environment to sync 
project documents and the CAD workspace.  Users can check with mathew.calkins@ct.gov 
to check if their company is already added to the approved list. 
To obtain access to CTDOT's SharePoint/COMPASS Environment: 

1. For initial login instructions visit: Getting Started with SharePoint for Consultants. 

2. The company's firm will need to fill out this form and submit their GUID to CTDOT.  This 
only needs to be done once per firm: GUID Submission Form. 

3. After a company is added to the whitelist, CAD users must request to have their MFA 
removed.  Syncing will not be possible until MFA is disabled. Each employee will need to 
fill out this form: MFA Access Package. 

4. To gain access to a specific project in COMPASS, users need to request access from the 
Project Manager on the project. 

5. For initial login instructions visit: Getting Started with SharePoint for Consultants. 

6. More information regarding COMPASS can be found here: DOT COMPASS Knowledge 
Center - Home. 

https://portal.ct.gov/dot/engineering-applications/getting-started-with-sharepoint-for-consultants?language=en_US
https://forms.office.com/g/ackwXKv0tm
https://myaccess.microsoft.com/@ct.gov#/access-packages/152f8511-e6c0-478e-811e-3739f900b33f
https://portal.ct.gov/dot/engineering-applications/getting-started-with-sharepoint-for-consultants
https://ctgovexec.sharepoint.com/sites/DOTCOMPASSKnowledgeCenter/SitePages/LearningTeamHome.aspx
https://ctgovexec.sharepoint.com/sites/DOTCOMPASSKnowledgeCenter/SitePages/LearningTeamHome.aspx
https://www.youtube.com/embed/8Ako3VrPMLU?feature=oembed
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2.2.3 Syncing the SharePoint DDE 

1. Browse to the State of Connecticut SharePoint site DOT CTDOT_DDE. 

2. In the sidebar, select CONNECT. 

3. On the top bar, select Sync. 

4. Select Open. You will be asked to set up a new OneDrive area. Follow the prompts to sign 
in again and continue clicking through the messages. 

 
Figure 21 DDE SharePoint Page 

5. OpenBuildings users will also need to sync an additional folder on the CTDOT_DDE 
SharePoint page. In the left side menu, click on CONNECT_OBD_Dataset and then select 
the Sync icon. 

 
Figure 22 CONNECT SharePoint Page 

https://ctgovexec.sharepoint.com/sites/DOTCTDOT_DDE
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6. Open File Explorer and verify the State of Connecticut DOT CTDOT_DDE – CONNECT folder 
is now syncing with your machine. Changes you make will be reflected in the SharePoint 
server and vice-versa. This ensures your CAD WorkSpace is always up to date with the 
latest CTDOT standards and configurations. 

 
Figure 23 DDE File Menu Synced DDE 
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2.2.4 Requesting a CAD Project in COMPASS 

1. In File Explorer browse to: 

 …State of Connecticut\DOT CTDOT_DDE - CONNECT\CT_CompassProjects 

Search for your project number. If you do not see your project’s corresponding *.cfg file, 
you will need to request one via this procedure. 

2. Project Engineers will need to request a CAD setup for new projects stored in COMPASS 
using the link below.  This will enable AEC Applications to properly configure the 
COMPASS Project's Design Folder and Discipline Subfolders.  

New CAD Workset Request - CAD Support Portal - Jira Service Management 

3. AEC Applications will set up the WorkSet and the CTDOT Property Fields with the 
information initially provided in the request.  

• CTDOT Project Description 
• CTDOT Project Number 
• CTDOT Town(s) 

The CTDOT Property Fields can be updated by anyone working on the project at any 
time as needed.  On the Splash Screen before opening a DGN file select Properties > 
Advanced Properties.  In the Edit WorkSet dialog box update the CTDOT Property 
Fields as required.  The Contract Border Cell Title Block placed in Sheets Models are 
linked to these Property Fields. 

  
Figure 24 CTDOT DDE WorkSet Properties 

https://ctdotcompass.atlassian.net/servicedesk/customer/portal/8/group/24/create/100
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2.2.5 Syncing a COMPASS Project 
CAD files shall be stored in O365 and COMPASS and worked on through the OneDrive App.  
1. Access COMPASS. 

2. Search the desired project and navigate to the Project Dashboard. In the left side menu, 
click on Design.  

  

Figure 25 WorkSet Design Folder 

3. On the Design page click Sync. 

 
Figure 26 Sync WorkSet Folder 
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2.2.6 Creating Custom Icons for launching Applications 

1. Create copies of the installed CONNECT products’ shortcuts on the Desktop. Rename 
them with a CT_ prefix.  

2. Right click the copied icons and choose Properties.  

Edit the Target line to include the bolded text (command line arguments) shown below. 
The beginning section contains the program’s install location and should not be 
changed. If your Bentley products are installed somewhere other than the default 
location, the path may appear differently than the below examples. 

OpenRoads Designer 
"C:\Program Files\Bentley\OpenRoads Designer CONNECT 
Edition\OpenRoadsDesigner\OpenRoadsDesigner.exe" "-wc%USERPROFILE%\State of 
Connecticut\DOT CTDOT_DDE - CONNECT\CT_ConfigurationSetup_Compass.cfg" 

  

OpenBridge Designer 
"C:\Program Files\Bentley\OpenBridge Designer CONNECT 
Edition\OpenBridgeDesigner\OpenBridgeDesigner.exe" OBM_PARAMS="-
wc%USERPROFILE%\State of Connecticut\DOT CTDOT_DDE - 
CONNECT\CT_ConfigurationSetup_Compass.cfg" 

 

OpenBridge Modeler 
"C:\Program Files\Bentley\OpenBridge Designer CONNECT 
Edition\OpenBridgeDesigner\OpenBridgeDesigner.exe" "-wc%USERPROFILE%\State of 
Connecticut\DOT CTDOT_DDE - CONNECT\CT_ConfigurationSetup_Compass.cfg" 

  

OpenBuildings Designer 
"C:\Program Files\Bentley\OpenBuildings CONNECT 
Edition\OpenBuildingsDesigner\OpenBuildingsDesigner.exe" "-
wc%USERPROFILE%\State of Connecticut\DOT CTDOT_DDE - 
CONNECT\CT_ConfigurationSetup_Compass.cfg" 

3. Click Apply and OK. 
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2.3 Consultant Install 
This module is intended for consultant engineers, municipalities and any other private parties 
to set up the CTDOT CONNECT DDE.  This is the second option outside parties can utilize if they 
are unable or do not wish to Sync to the DDE SharePoint site 0 Consultant Sync  This module 
is not intended for CTDOT staff at Newington HQ or district offices, as the DDE has already been 
set up on SharePoint. 

Before continuing, please ensure one of the relevant CONNECT Edition applications have been 
installed. The CTDOT CONNECT DDE is configured to work with: 

• OpenRoads Designer®  
• OpenBridge Modeler® or OpenBridge Designer®  
• OpenRail Designer® 
• OpenBuildings Designer®  

All products contain the functionality of MicroStation CONNECT Edition in addition to relevant 
design capabilities for each product. Note that OpenBridge Modeler is the CAD component of 
OpenBridge Designer. CTDOT will not support the use of plain MicroStation CONNECT Edition 
with our standard configuration files as only OpenRoads Designer, OpenBridge Modeler, 
OpenRain Designer, and OpenBuildings Designer align with BIM functionality needed to move 
design data through its lifecycle. 

2.3.1 DDE Download and Install 
CTDOT provides a Zip file for download located on the CONNECT Edition DDE Website. The 
Zip file contains Configuration files/folders as well as a CTDOT template WorkSet (Project) 
Container. Before installing it’s imperative to determine the locations in which you will be 
storing the CT CONNECT DDE Configurations and the CTDOT Project folders (WorkSets). 
Step through the following to install the CTDOT CONNECT DDE: 
1. Download/Copy CT_CONNECT_DDE.Zip from the CTDOT CONNECT DDE website to the 

Desktop. 

 
Figure 27 Download DDE 

https://portal.ct.gov/DOT/Engineering-Applications/CTDOT---CONNECT-DDE
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2. Right click on the copied zip folder Icon and choose Extract All…Browse to the 
destination that will house the CT CONNECT DDE Configurations (this can be either a 
local folder or network drive/folder) and click the Extract button. 

 
Figure 28 CTDOT DDE Zip File extraction 

3. Determine the location where your project data will be stored. It may be kept in the 
original extracted location or moved out.If required, move the CT_Projects folder out 
from the CT_CONNECT_DDE folder into a different location. 

4. Double click CT_ConfigurationSetup.cfg to open it using a text editor. 

5. Edit both the CT_WORKSPACE_INSTALL path (CT_CONNECT_DDE) 
and CT_WORKSET_INSTALL path. 
Example: 
CT_WORKSPACE_INSTALL = L:/CT_CONNECT_DDE/ 
CT_WORKSET_INSTALL = T:/CT_Projects/ 

6. Choose File> Save and Close or Exit. 

 
Figure 29 CT_ConfigurationSetup.cfg 
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7. Create a desktop copy of the installed CONNECT products’ shortcuts to edit.Rename it 
with a CT_ prefix. 

  
Figure 30 Copying Icons 

8. Right click the copied Icons to choose Properties. 

 
Figure 31 Icon Properties 

9. Edit the Target line by appending a command line argument as shown below. Also edit 
the WorkSpace install drive letter (and path if necessary) to the correct location of 
CT_ConfigurationSetup.cfg. Note: The Program installed location in the front section 
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(ending in exe) should not be changed and maybe different than what is shown below if 
your program is installed in a different location. 
OpenRoads Designer 
"C:\Program Files\Bentley\OpenRoads Designer CONNECT 
Edition\OpenRoadsDesigner\OpenRoadsDesigner.exe" -wcL:\CT_ConfigurationSetup.cfg 
 
 OpenBridge Designer 
"C:\Program Files\Bentley\OpenBridge Designer CONNECT 
Edition\OpenBridgeDesigner\OpenBridgeDesigner.exe" OBM_PARAMS="-
wcL:\CT_ConfigurationSetup.cfg" 
 
 OpenBridge Modeler 
"C:\Program Files\Bentley\OpenBridge Designer CONNECT 
Edition\OpenBridgeDesigner\OpenBridgeDesigner.exe" -wcL:\CT_ConfigurationSetup.cfg 
  
OpenBuildings Designer 
"C:\Program Files\Bentley\OpenBuildings CONNECT 
Edition\OpenBuildingsDesigner\OpenBuildingsDesigner.exe" -
wcL:\CT_ConfigurationSetup.cfg 

 
Figure 32 Modify Icon Target 

10. Click Apply and OK. 

11. Share/Email your configured target line to your companies’ end users so that they may set 
up their own desktop Icon as well. 
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2.3.2 Installing the OpenBuildings Designer Dataset 
This Module will need to be completed for anyone using OpenBuildings Designer. The 
procedure below will not be needed for use with OpenRoads or OpenBridge.  

1. Browse to CTDOT CONNECT DDE Website. 

2. Click on the OpenBuildings Designer Dataset link.  A Zip file will be downloaded to your 
downloads folder. 

 
Figure 33 Download OpenBuildings DataSet 

3. Un-Zip it to the C Drive. C:\CT_OpenBuildingsDesigner_Dataset 

 
Figure 34 File Explorer C Drive 

Note:  To Update the files delete the CT_OpenBuildingsDesigner_Dataset folder on your C 
Drive and repeat steps 1 -3. 

https://portal.ct.gov/DOT/Engineering-Applications/CTDOT---CONNECT-DDE
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2.3.3 Creating a WorkSet  

Use these steps to create a WorkSet for: 
• OpenRoads Designer 
• OpenRail Designer 
• OpenBridge Modeler 
• OpenBuldings designer 

1. To create Project Containers (WorkSets) double click the CTDOT icon to first launch ORD 
or OBD.   

2. For the WorkSpace select the CT_WorkSpace  

3. For the WorkSet, choose Create WorkSet  

4. Create a new WorkSet by entering the CTDOT Project Number for the Name and 
choose CT_Workset from the Template drop down. 

 
Figure 35 WorkSet Creation 

5. On the Splash Screen before opening a DGN file select Properties > Advanced 
Properties.  In the Edit WorkSet dialog box update the CTDOT Property Fields as 
required.  The Contract Border Cell Title Block placed in Sheet Models are linked to these 
Property Fields. This is what will appear in the Contract Sheet Title Block so use all 
CAPITALS. 
• CTDOT Project Description 
• CTDOT Project Number 
• CTDOT Town(s) 
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Figure 36 CTDOT DDE WorkSet Properties 
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2.3.4 Creating a WorkSet Using Open Bridge Designer 
This section is only applicable if OpenBridge Modeler (OBM) is to be used exclusively. In 
order to use OBM, an OpenBridge Designer file (*.obdx) must first be selected or created. 

1. Double click the CTDOT icon to launch OpenBridge Designer. 

2. Click New File, include the project number in the file name 
(example 1234_1234_Temp.obdx) and save it to your desktop. 

 
Figure 37 OpenBridge New Template File 

3. Back on the Launcher create a new standalone group by clicking on the yellow folder 
with the green plus sign. Name it Temp. 

4. Ensure that Standalone has been selected (not BIM Workflow). Select the Standalone 
Group: Temp to expose the OpenBridge Modeler icon and click it. 

 
Figure 38 Open OpenBridge Modeler 
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5. From the splash screen, ensure that the CT_WorkSpace has been selected 
and choose Create a WorkSet. 

6. Create a new WorkSet by entering the CTDOT Project Number for the Name and 
choose CT_Workset from the Template drop down. 

7. On the Splash Screen before opening a DGN file select Properties > Advanced 
Properties.  In the Edit WorkSet dialog box update the CTDOT Property Fields as 
required.  The Contract Border Cell Title Block placed in Sheet Models are linked to these 
Property Fields. This is what will appear in the Contract Sheet Title Block so use all 
CAPITALS. 
• CTDOT Project Description 
• CTDOT Project Number 
• CTDOT Town(s) 

 
Figure 39 CTDOT DDE WorkSet Properties 

 
8. Now that the WorkSet has been created, exit OBM. 
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2.3.5 Updating WorkSet Properties 
New WorkSet properties have been established for use with the Contract Border Title 
Block that suspends the need to connect up to projects in Bentley Cloud Services. 
Consultants will no longer need to browse to “Associate Project To Workset” when 
creating a new WorkSet. 

New projects and newly placed Borders will now read custom CTDOT Fields. Existing 
WorkSets created before the CTDOT Custom property fields were put into place can 
be manually added. 

1. On the Splash Screen before opening a DGN file select the WorkSet to update. 
Next select Properties > Advanced Properties.  

2. In the Edit WorkSet dialog box click on Add a Custom Property and copy and paste the 
following text and create three new properties. 

• CTDOT Project Description 
• CTDOT Project Number 
• CTDOT Town(s) 

3. Update the CTDOT Property Fields as required.  The Contract Border Cell Title Block 
placed in Sheet Models are linked to these Property Fields. This is what will appear in the 
Contract Sheet Title Block so use all CAPITALS. This will update the WorkSet's DGNWS file 
that was established when the WorkSet was originally created. 

These properties can be updated at any time and the new Title Block will read in the 
updated info. Title Blocks requiring an update using Border Cells placed before the new 
properties were put into place should be deleted and a new Border Cell should be placed. 

2.3.6  Creating Custom Icons for launching Applications 
1. Create a desktop copy of the installed CONNECT products’ shortcuts to edit.Rename it 

with a CT_ prefix. 

 
Figure 40 Copying Icons 
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2. Right click the copied Icon to choose Properties. 

 
Figure 41 Icon Properties 

3. Edit the Target line by appending a command line argument as shown below. Also edit 
the WorkSpace install drive letter (and path if necessary) to the correct location of 
CT_ConfigurationSetup.cfg. 

OpenRoads Designer 
"C:\Program Files\Bentley\OpenRoads Designer CONNECT 
Edition\OpenRoadsDesigner\OpenRoadsDesigner.exe" -
wcL:\CT_ConfigurationSetup.cfg 
 
OpenBridge Designer/OpenBridge Modeler 
"C:\Program Files\Bentley\OpenBridge Designer CONNECT 
Edition\OpenBridgeDesigner\OpenBridgeDesigner.exe" OBM_PARAMS="-
wcL:\CT_ConfigurationSetup.cfg" 
 
OpenBuildings Designer 
"C:\Program Files\Bentley\OpenBuildings CONNECT 
Edition\OpenBuildingsDesigner\OpenBuildingsDesigner.exe" -
wcL:\CT_ConfigurationSetup.cfg 
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Figure 42 Modify Icon Target 

4. Click Apply and OK. 
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2.3.7 Updating The Master Bid Item List 
The master bid item list can be found on CTDOT’s Contract Development Webpage.  Both 
the Excel Files and PDF files are periodically updated on this website: Contract Development 

Item Types in CAD uses a lookup table to find Pay Items.  AEC Applications will update 
CTDOT’s CONNECT Configuration files in SharePoint so that the Item Types will link to 
Contract Development's updated data. Consultants that have downloaded the workspace 
from the CTDOT - CONNECT DDE website will need to manually replace this data as 
Contract Development updates their website. 

The Following step are for consultants not using CTDOT's SharePoint Workspace, in-
house designers and consultants using CTDOT's SharePoint Workspace will not need to 
do this. 

1. In File Explorer, browse to CT_CONNECT_DDE\CT_Configuration\Organization\Item 
Types\Lookup TableAsset_Lookup_All.xlsx. Open and delete the itemavg_eng tab. 

2. Go to Contract Development, under Master Bid Item Lists, click on the English Excel File. 

3. Open the downloaded excel file and copy Sheet 1 tab to Lookup 
TableAsset_Lookup_All.xlsx.  Rename Sheet 1 tab to itemavg_eng. 

 
Figure 43 Excel File Replace Master Pay Item Tab 

4. Verify that Cell A1reads Item_Number. 

https://portal.ct.gov/dot/contract-development-and-estimating/contract-development
https://portal.ct.gov/dot/engineering-applications/ctdot---connect-dde
https://portal.ct.gov/dot/contract-development-and-estimating/contract-development
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Figure 44 Excel File edit Item Number Column 

5. Create a column called Search and merge/copy columns Item_Number 
(A) and Description (C) into the new column. 

6. Verify that the last item in the list is N/A in the following columns. 
• Item_Number 
• Description 
• Unit 
• Search 

 
Figure 45 – Excel file add an N/A Row 

7. Save and close both of the Excel files. 



Volume 1 - Getting Started 

27 
 

2.3.8 Updating the DDE 
This Module is for users/consultants that have manually installed the DDE. CTDOT 
Employees that are connected to the Network do not need to update the DDE as this is done 
by AEC Applications. 

Sign up for E-News Alerts 
CTDOT E-News Alerts will notify users when an update to the DDE has been posted. 

1. Click here to subscribe to receive updates from the Connecticut Department of 
Transportation 

2. Enter your Name and Email.  Continue to the middle section and check off all the 
updates you would like to receive. For DDE updates be sure to check off Yes, I’d like to 
receive Engineering Application CAD Updates. 

3. Scroll to the bottom and click the Subscribe button. 

 
Figure 46 CTDOT E-New Alert Sign up 

https://confirmsubscription.com/h/j/B442E21CC5D87BEB
https://confirmsubscription.com/h/j/B442E21CC5D87BEB
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Download Zip 
1. Browse to the posted Zip and download it. CTDOT CONNECT DDE Website 

 
Figure 47 Download DDE 

2. Double click on the Zip file to see the folders. 

3. Browse to …CT_CONNECT_DDE.zip\CT_CONNECT_DDE 

4. Select the CT_Configuration folder and copy to replace the previous install.  

 
Figure 48 File Explorer Copy Configuration 

https://portal.ct.gov/DOT/Engineering-Applications/CTDOT---CONNECT-DDE
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5. Double click on the CT_Projects folder. Select the CT_Workset (CTDOT’s Template 
WorkSet) folder and corresponding files, right click and select Copy.  Paste and replace 
in the installed location. 

 
Figure 49 File Explorer Update Workspace Template 
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Section 3 - Beginning a Work Session 

3.1 Accessing the Application 
Before attempting to open or create DGN files users should make sure one of the scenarios in 
Section 2 of this Volume has been completed. 

1. Log on to the CONNECTION Client. 
Bentley Connect licensing requires users to log into their Bentley account to secure a 
software license. CTDOT users should log in using your CTDOT email address and Bentley 
password.If you do not see the dialog box, select the ˄ icon on the bottom Windows Screen. 
Click on the Connection Client Icon and select Open. 

     
Figure 50 CONNECTION Client System tray 

2. Launch the Application. 
• Consultants 

Start the software 
 via an appropriate CTDOT DDE icon and skip to step 5. 

 

• CTDOT employees 
On your desktop double click on the  
CAD Accounting Icon. 

 
 
 

Figure 52 CAD 
Accounting 

Icon 

Figure 51 ORD 
Icon 
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3. For this current version of the Accounting Menu, the following will appear on the first use of 
the menu. 

a. Find your Windows User at Work user log in name from dropdown list and select it. 

b. If it is not in the list enter it in the blank field below the drop-down list. Un-sure of your 
user log in name, open File Explorer D:\Users\... and find your name.  If the Username is 
rejected, then: 
• non-DOT employee, and you have permission from that user, please select 

that existing username from the dropdown list to use as proxy. 

• DOT employee, please contact dot.helpdesk@ct.gov to add your name to the CAD 
Accounting PC name table. 

d. Find your Computer Name at Work from dropdown list and select it. 
• If it is not in the list enter it in the blank field below the drop-down list. Un-sure of 

your computer name go to your Desktop and double click on the WorkStation 
Information Icon.  Make note of the Computer Name:  

• If the Computer Name is rejected, then: 
o the computer is a non-DOT one, or one not on the DOT network, please select 

an existing computer name from the dropdown list to use as proxy. 

o the computer is a DOT PC, please contact Desktop Support to add the PC to 
the CAD Accounting PC name table. 

e. Back on the Configure Windows User and Computer Name dialog box click Save. 

 
Figure 53 CAD Accounting Initial Setup 

mailto:dot.helpdesk@ct.gov
mailto:dot.helpdesk@ct.gov
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4. On the CT DOT Accounting Menu there will be several applications to pick. 
The following will default to the synced COMPASS\Design Project location and the 
Synced State of Connecticut DDE SharePoint Workspace 

• Compass OpenBridge CE 
• Compass OpenBuildings CE 
• Compass OpenRoads CE 

The following will default to your personal synced State of Connecticut OneDrive 
location and the Synced State of Connecticut DDE SharePoint Workspace 

• Non-Projects OpenBridge CE 
• Non-Projects OpenBuildings CE 
• Non-Projects OpenRoads CE 

In the Run Program field select the needed program, the Available Account (funding 
source) and Resource Type. Click on the Start button to load the program. 

 
Figure 54 CAD Accounting dialog box   
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5. After launching the program, the following will appear. 
For - OpenRoads Designer, OpenRail Designer and OpenBridge Modeler, OpenBuildings 
Designer a Welcome Screen.  Users will continue to Step 6. 

   
Figure 55 OpenX Splash Screen 

For - OpenBridge Designer 
A home dialog box for OpenBridge Designer will open. Users will need to complete a. 
and b. below before moving on to Step 6.  

a. On the OpenBridge Designer Home dialog box select New to create a new OBDX 
file in the Bridge subfolder within the WorkSet. This file can also be stored locally on 
your C or D drive. Name the file with your initials and project number 
(example: EHR_1234_1234_CAD_Only.obdx). This file will only be accessed by one 
user, everyone working on the project should have their own.  

Note: If performing analytics using LEAP Bridge Steel, Leap Bridge Concrete or 
RM bridge create a separate OBDX file in the Bridge subfolder within the 
WorkSet; using the Project Number in the naming convention 
(example: 1234_1234_Analytics.obdx). This file should only be selected when 
users plan to do analytics, the project team should coordinate its usage as 
only one person should be accessing it at a time. 
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Figure 56 OpenBridge Designer Launcher 

b. On the left side menu unsure that Standalone has been selected (not BIM 
Workflow). Select or create a New Group to expose the OpenBridge Modeler 
icon. On the left menu make sure you a have the Group selected not a DGN 
file. After selecting the Group click on the OpenBridge Modeler icon. 

  
Figure 57 OenBridge Modeler Launcher 

Note: Additional applications are available by clicking on the  Analysis or 
the Interop. buttons. Instructions on how to use these applications are not 
part of the CTDOT CONNECT DDE, visit Bentley's website for further instructions. 
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Figure 58 OpenBridge Designer Applications 

6. Ensure you are using the Custom Configuration and CT_WorkSpace, then select the 
relevant WorkSet and Role. The example below shows the options available in 
OpenRoads Designer. The other applications will look similar. The WorkSets listed 
correspond to project numbers and will be the same for all products. 

Note: If you do not see the Project Number listed, please request a Compass/CAD 
Setup using this link  New CAD Project Request 

 
Figure 59 OpenBridge Modeler Splash Screen 

https://ctdotcompass.atlassian.net/servicedesk/customer/portal/8/group/24/create/100
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7. Browse to open an existing file or select New File.  Browse to your specific discipline folder 
inside the Project.  

 

8. Select the New File icon to create a new file. 

From the New dialog box, browse to the proper discipline folder and enter the proper file 
name in the File name: field using 
“DisciplineDesignator_Project_Number_Description.dgn” 

Highway Example: HW_1234_1234_BaseModel.dgn 

9. On the New dialog box click the Browse button to select the proper seed file. See below for 
each application's seed file locations. 

OpenRoads Designer: 
 …CT_Configuration\Organization\Seed\Road 

OpenBridge Modeler: 
…CT_Configuration\Organization\Seed\Bridge 

OpenBuildings Designer: 
…CT_Configuration\Organization\Seed\Buildings 

 

10. After the DGN file is created open File Explorer and browse to the file, right click and select 
View online. 

  
Figure 60 File Explorer View online tool 

Warning: Do not copy DGN files created with V8i SELECTseries or InRoads SS2, SS3, SS4, 
or SS10 to the new CTDOT CONNECT Project/WorkSet folders.  
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11. The Projects SharePoint site will open, sort by Date, click on the three dots, select More > 
Check Out 

Note: When you are done working on the DGN file, exit the program and go back to 
the SharePoint Site and Check In the file. 

 
Figure 61 SharePoint Check out 
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3.2 Model Types 
OpenRoads Designer and OpenBridge Modeler utilizes three different types of models: Design, 
Drawing and Sheet. 

• Design (Base Models): Consists of design geometry, can be 2D or 3D, and contains the 
elements that represent what is built, drawn at full scale (1:1), these types of models will be 
considered Base Models for the CTDOT CONNECT DDE. This model has a default black 
background. 

• Drawing: This type of model is used to apply annotation. It stores a subset of a 2D or 3D 
design model or design composition. It is always 2D and has a default grey background. 

• Sheet: This model is for plotting purposes only. It serves as an electronic drawing sheet and 
is used to define printed output, ready for printing or publishing. The sheet model includes a 
boundary, sheet information, and additional sheet annotation. All mapping and design 
features that have coordinate location values associated with them shall maintain those 
coordinate values within the CAD files. It is always 2D and has a default black background. 

 
Figure 62 Model Types 
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Base Models 

CTDOT uses various base model design files to store plan, profile, and corridor modeling 
information in real world dimensions. These files are then referenced into drawing models and 
contract sheet design files to produce the plan sheets for the project. 

Several base model files may be used depending on the project complexity. 

• The CTDOT CAD Standards allow for multiple base model design files for each unique discipline 
(survey, illumination, landscape, highway, drainage, signals, pavement marking, signs etc.). 

• Base models can be further broken up based on project needs by site or area to allow for 
multiple people in the same discipline to work on the project. For large projects it is 
recommended to store each alignment in a separate design file. This “federated” approach 
will allow multiple designers to work on different alignments simultaneously. If multiple 
geometry base models are used a “collector” design file should be created. This file is an 
empty design file with a reference attachment for each geometry base model. This allows 
users of the project to easily access all the geometry for the project by attaching the collector 
file as a reference with a nest depth value of 1. 

Note: As graphic elements are drawn in each base model design file, these graphics are 
displayed in the “collector” file, according to the setting of the configuration variable 
MS_REF_NEWLEVELDISPLAY. This variable is defined as follows: MS_REF_NEWLEVELDISPLAY = 1. With 
this setting, as new elements are drawn in the various federated base models, the graphics is 
automatically displayed in the “Collector” file. In some cases, this behavior is desirable as it allows 
new and information to be automatically displayed on any plan sheets that reference one or 
more of the federated base models. Other users may find this behavior frustrating as the level for 
any new graphics must be manually turned off for each reference attachment. The default 
variable definition can be overwritten when a reference file is attached by setting the New Level 
Display parameter to a value of Never, as shown below. 

 
Figure 63 Reference Level Display Setting 
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ORD creates a 3D model from your 2D design, storing the civil data in the DGN files. These DGN files 
will be required for projects that typically include earthwork. 

Examples of 3D project types include: 
• New Roadways 
• Widening 
• Bridge replacements 
• Interchange reconstruction 
• Roundabouts 
• Turn lanes 
• Passing lanes 

 

3D model files may not be required for projects that do not propose earthwork/grading 
operations. 

Examples of such project types include: 
• Lighting 
• Bridge Rehabilitation without approach grading and paving 
• Resurfacing without significant grading operations 
• Landscaping 
• Signal upgrades 
• Signing/striping upgrades 
• Noise walls 
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Drawing Models 
In the CONNECT Edition we will be creating a model type called the Drawing Model. This is not a 
new concept to, but it has not been used in previous CTDOT workflows. 

The Drawing model is an intermediate stage between the 3D Design and the printable Sheet 
Model. They will be used it in the Drawing Composition workflow to centralize annotations that 
need to be shared across multiple sheets. Users are locked from being able to place Geometry or 
Modeling Features in a Drawing Model. The following message will appear. 

 
Figure 64 Error Message 

Drawing Model Rules: 
• References the Base Model and it cuts up using a Named boundary 
• Contain Annotation (Call outs) and Dimensions 
• Are geospatial 
• Automatically gets created when using the Place Named Boundary tools. 

The creation of Drawing Models can be automated by utilizing the Place Named Boundary Tools. 
More information on creating Drawing Models can be found in Volume 13. 

 
Figure 65 Sheet Creation Tools 
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Sheet Models 

Creating a Sheet model for printing as a drawing, typically involves working with the following 
components: 

• Referencing Base and Drawing models. 
• Saved views — Used to set up views required for the drawing. 
• Border Cell Placement — Contains the border graphics and title block for plotted output. 

There is no hard and fast rule about how to create Sheet models, or how to display your drawing 
information from your design or drawing models. Commonly, either of two methods are used, one 
that scales the border to enclose the design, or the other that scales the design to fit the border. 

With both methods, for 3D work in particular, it is a good idea to have separate design models 
(base models), drawing models and sheet models. This lets you keep the purely drawing 
information, such as text and dimensioning, separate from the design information. Doing this 
reduces the likelihood of conflicts where others, for example, wish to reference the same design 
model for use in a drawing of a different scale. 

Creating Sheet Models automates the creation of drawing sheets for the printing of your designs. 
This process is similar to how the manual draftsperson works. Where it differs, however, is that 
instead of redrawing the model's geometry for each view, like the manual system requires, you 
simply attach views of the design model as references. 

In other words, you attach as references views of your design geometry for each plan, elevation, 
section, and so on. The power of this system is that any changes made to the design model is 
then reflected immediately in each affected view of the drawings. 

The creation of Sheet Models can be automated by utilizing the Place Named Boundary 
Tools. More information on creating Sheet models can be found in Volume 13. 

 
Figure 66 Sheet Model DGN with Border 
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3.3 The Interface 

3.3.1 Workflows 
OpenRoads tools can be accessed a variety of ways, including the familiar Ribbon 
interface. Ribbons are arranged by Workflows, which are selected from a pull-down in the 
upper left corner of the software. 

OpenRoads Designer comes with Multiple Workflows. 
• OpenRoads Modeling 
• OpenRoads Plans Production 
• Survey 
• Geotechnical 
• Reality Modeling 
• Drawing 
• Drainage and Utilities 

The CTDOT is a custom workflow supplied with the CTDOT CONNECT DDE 

 
Figure 67 CTDOT Workflow 
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3.3.2 Onscreen Prompts 

Prompts 
All civil tools display on-screen prompts, which accept the inputs needed to create each 
element. Dynamic feedback is displayed while you are creating elements. It is another way 
of providing useful information while maintaining focus on the work. Providing this 
information as you are creating elements helps you make better design decisions in a 
shorter time.  

 
Figure 68 Onscreen Prompts 

Manipulators and Handlers 
When any element created by a Civil Geometry tool is selected, certain manipulators are 
displayed dynamically. These manipulators vary by element type. 

 
Figure 69 Manipulators and Handlers 

Civil Message Center 
Provides feedback on a variety of issues that can affect the design process, such as errors 
in constructions and design standards that have been violated. 

 
Figure 70 Civil Message Center 
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3.3.3 Setting Up the Interface 

1. On the Ribbon Home Tab > Primary grouping select the Explorer button. The dialog may 
be docked (collapsed) on the side of the interface. It can be dragged, docked, 
undocked, pinned and unpinned. 

2. To dock the dialog, drag it by the title bar to a “docking glyph”. Pin or un-pin as desired. 
The Explorer dialog is used extensively, you want it readily available. Experiment to find 
the balance between ease of access and taking up screen space. 

 
Figure 71 Pin Menu  

3. If you do not see everything you need to select Back Stage File > Settings > User > 
Explorer Settings and adjust as needed. 



Volume 1 - Getting Started 

46 
 

4. Once you find a setting that you like, you can click the Save Settings command. 

 
Figure 72 Explorer Menu Options 

5. On the Ribbon Home Tab > Primary grouping select the Properties button. To turn on 
the Properties Dialog box select the Properties button on the ribbon. This dialog may be 
docked (collapsed) on the side of the interface. It can be dragged, docked, undocked, 
pinned and unpinned. 
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6. To dock the dialog, drag it by the title bar to a “docking glyph”. The Properties dialog is 
used extensively, you want it readily available. Experiment to find the balance between 
ease of access and taking up screen space. 

 
Figure 73 Properties dialog box 

7. Once you find a setting that you like, you can click the Save Settings. 
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Section 4 - Maintaining the DDE and UPF 

4.1 Managing User Preferences 

4.1.1 Viewing User Preferences 
What are User Preference Files? 
CONNECT Applications store user settings in several preference files. These files contain 
information such as user settings in the Preferences dialog box, your button assignments, 
the location of opened toolboxes, key-in history and much more.    
1. On the bottom of your (Windows) screen select the Folder Icon.   

2. On the View tab select Options. 

 
Figure 74 File Explorer View Options 

3. On the folder Options dialog box select the View Tab.  
Show Hidden files, folders and drives should be toggled on. 
Hide extensions for known type should be off. 

4. Click Apply to all Folders, OK and Cancel. 

 
Figure 75 File Explorer Folder Options 
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5. Browse to one of the following locations and explore the files and folders. Please note: 

Most CTDOT Computers will point to the C Drive, but older desktops may still point to 
the D Drive location. Consultants should search for their installed Windows user 
location as this could vary from how internal CTDOT Computers are configured. 

C:\Users\YourName\AppData\Local\Bentley\Open… 
Warning: 
• When OpenRoads Designer, OpenBridge Modeler or OpenBuildings Designer 

Application is upgraded users will need to wipe out all their old User Preference 
folders and files. If users try to use older files they will most definitely run into 
issues.  

• User Preference folders and files occasionally become corrupt. This can 
happen after a crash or for no apparent reason dialog boxes are missing, example 
Tool Settings Dialog box. They appear open under the Window List but are not 
visible on the screen. When this happens, it is necessary to delete all your user 
preferences files and folders. 

4.1.2 Deleting User Preferences 
Say OpenRoads, OpenBridge, OpenRail, or OpenBuilding is behaving strangely. For example, 
Toolboxes aren't where you left them, views won't tile, cannot access certain tools, getting 
error messages, the application is locking up… These all could be indications that your User 
Preference Files are corrupt. 

Why do these files tend to get corrupted? 
• The applications write to these files every time you open or move a tool window, or when 

you change any other setting that is kept in the UPF or programed though an XML. These 
files are dynamic and will grow in size as your preferences change; in some instances 
when the files become too large, they may become unstable or even corrupt. 

• Corruption may occur from running two or more copies of the same application at once. 
Each copy is writing to the same local user preference folders. They can get out of sync 
with each other and end up corrupting the files. 

• If you were prematurely booted out and did not get the opportunity to exit properly.  

How can I diagnose the problem? 
The user preference files are some of the most important files the applications depend on 
to run correctly; that is why these files are always a suspect when one of the applications 
fails to work as expected or fails unexplainably. The list of problems possibly caused by a 
corrupted user preference files are too extensive to list, but fortunately these problems are 
fairly easy to diagnose and easy to fix. 
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• If a specific problem is experienced simultaneously by several different people, it 
is MOST LIKELY NOT caused by your personal user preference files (each login ID has a 
separate local user preference storage area). If anyone’s user preference files are 
corrupt and causing a problem, it is not likely this exact problem will be experienced 
simultaneously by other users. 

• If the problem is experienced in only one particular DGN file but not in other files, it 
is MOST LIKELY NOT due to bad user preference files. The user preference files control the 
behavior of application regardless of the file being accessed; therefore, problems 
evident in only a single file usually indicate a problem with that particular DGN file. If the 
same problem occurs in multiple DGN files opened by a single user, this is a likely 
indication of user preference file corruption. 

• If the problem is experienced by the same person on more than one computer, it 
is MOST LIKELY NOT caused by corrupted user preference files. User preference files 
reside on the local hard drive and will not be carried over to another machine. 

• If the problem is experienced by only one person, on a single computer, regardless of 
the file being accessed, then this is MOST LIKEY caused by a corrupt user preference 
file.  

How can I fix the problem? 
It is important to know that a User Preference Files (UPFs) cannot be fixed; if they get corrupt 
you will need to wipe them out and create new ones from the files provided with the 
software installation. The UPF problem can be fixed but the UPFs themselves cannot be 
recovered. It is a good idea to keep a log of settings you regularly change when you get 
new UPFs.  

To create a new User Preference Files, follow the steps below: 

1. Exit OpenRoads, OpenBridge or OpenBuilding - The User Preference Files are accessed 
each time the application is started so to remove them you will need to be out of each 
program. 

2. Browse to the location of the application you are having issues with. Please note: Most 
CTDOT Computers will point to the C Drive, but older desktops may still point to the D 
Drive location. Consultants should search for their installed Windows user location as 
this could vary from how internal CTDOT Computers are configured. 

C:\Users\YourName\AppData\Local\Bentley\Open… 

3. Delete all of the files and folders under the specific program folder. 

4. Restart the application - All of these needed files will automatically get recreated when 
you open the program.  
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5. If the problem is gone, the old user preference files were at fault.  If the problem is not 
gone, it was not caused by the old User Preference Files.  Fill out the AEC Support Form 
and remember to mention that you have already tried recreating the User Preference 
Files and it did not help.  
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4.2 Updating from DGN Libraries 

DGN Libraries are sometimes upgraded when new versions of the CT DDE are released. 
• Styles, Element Templates, Item Types, and Parametric Cells 
• Item Type Pick lists 
• Feature Definitions (for OpenRoads and OpenBridge only) 

When you use a Style, Element Template, Item Type, or Parametric Cell from a DGN library, it is 
copied to your open DGN file and is given the same name. The following indicators allows you 
to compare the local resource to the DGN library resource with the same name, to see if the 
contents of the DGN library have changed, to see if the local resource is out of sync with 
the DGN library resource, and to selectively apply updates to the local resource. 

The following are indicators of the sync status. 

local style, matches library 

local style, different from library 

local style  

These resources can be updated using the Update from Library icon located in their 
corresponding dialog box. 

 Update from Library uses this icon for Parametric Cells. 
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4.2.1 Styles 

This exercise uses Text Styles to practice Updating from Library, these same procedures can 
be used throughout the applications for example Dimension Styles, Levels and Element 
Templates. 

1. In the DGN file’s search field type in Text Styles and select the results. 

2. On the Text Styles dialog box right click on the CTDOT_080_Center and select Save. On 
the General tab click on Bold and click on the Save Icon, notice the indicator update 
to local style, different from library. 

  
Figure 76 Modify Text Styles 

3. Select the Update from Library icon and notice the indicator go back to local style, 
matches library. 

  
Figure 77 Update Text Styles 
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4.2.2 Item Types 

1. In the DGN file’s search field type in Item Types and select the results. 

2. In the Item Types dialog box select Libraries > Update From Library 

 
Figure 78 

Item Type Pick lists can also get out of sync. The status icon indicators are the same as 
shown above but there is no Update from Library Icon/tool available at this time (this 
tool will be available in a future release of the software). Updates can be made with this 
workaround: 

3. In the DGN file’s search field type in Pick List and select the results. 

4. In the Pick List Manager right click and select Delete, then right click again and 
select Activate. 

 
Figure 79 Update Picklists 
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4.2.3 Feature Definitions 
This section relates to options in OpenRoads, OpenRail and OpenBridge.  There are two 
methods (Automatic and Manual) described in this section that you can use to update 
Feature Definitions. 

4.2.3.1 Automatic All Push Method  
This will also update Styles, Element Templates, and Item Types 
1. In the DGN file’s search field type in Explorer Settings and select the results. 

2. In the Explorer Setting dialog box ensure that OpenRoads Standards or OpenBridge 
Standards is marked as Visible. 

  
Figure 80 Update Explorer Settings 
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3. In the DGN Explorer dialog box click on the OpenRoads Standards or OpenBridge 
Standards section. Under Standards right click on the file (not the Libraries) and 
select Update From dgnlib. 

 
Figure 81 Update Feature DGNLIB 

4.2.3.2 Manual Method 
This will only update the Feature Definition 
View this video in Bentley Communities for a demonstration on the relationship between 
feature definitions in a DGNLIB and in the active DGN.  It also provides examples of how to 
update feature definitions in the active file in the event the DGNLIB is revised. 

 

Figure 82 Video: Updating Feature Definitions from a Revised DGNLIB 

https://www.youtube.com/embed/KJ_KmV2jhp0?feature=oembed
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4.3 Updating Bridge Templates 
This Module is for OpenBridge Modeler users and should be completed as needed when new 
OpenBridge Designer/Modeler versions are released. 
Bentley continually adds Bridge Templates with each version release of OpenBridge 
Designer/Modeler.CTDOT has the Bridge Templates stored in the Project (WorkSet 
location). This will allow Read\Write access to the Designers. It will be up to the designer to 
check their Project’s Standards folder to update these files. Keep in mind designers may have 
modified some of these files so a careful review should be followed when deciding what files to 
update. 

Files will be copied from 
….CT_Configuration\Organization-Civil\_CT_Bridge Standards - Imperial\OpenBridge 
Modeler\Bridge Templates 
to: 
….0000-0000 - Design\Standards\Bridge Templates 

  
Figure 83 Update Bridge Templates 
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4.4 Updating the Contract Sheet Title Block 
The Contract Border Cell Title Block placed in Sheet Models are linked to the WorkSet Property 
Fields. This workflow will update WorkSet Property Fields that was established when the WorkSet 
was originally created. The information is stored the WorkSet's 1234_1234.DGNWS file. 

1. Open the CAD application. 

• Consultants - Start the software, via an appropriate CTDOT DDE icon. 
• CTDOT employees - On your desktop double click on the Accounting Icon. 

2. On the Splash Screen before opening a DGN file select the WorkSet to update. 
Next select Properties > Advanced Properties.  

3. In the Edit WorkSet dialog box edit the following fields as necessary, this is what will appear 
in the Contract Sheet Title Block so use all CAPITALS: 

• CTDOT Project Description 
• CTDOT Project Number 
• CTDOT Town(s) 

4. Open the DGN file and check the sheet models. If the title block does not display the 
updated information use the tool Update All Fields, and the text will update to match. This 
can be done by typing the command in the upper right Search field or by selecting 
the More pull down on the CTDOT workflow, Annotate tab, Text section. 
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4.5 Updating the Border Cell 
The Contract Border Cell has been updated with a new layout and new logos. There are two 
process that can be used to update the Sheet Models: 

• Manual 
• Batch 

 
Figure 84 Update Border Cell 

Open the Design file that needs to be updated, before starting either process make sure the 
Annotation Scale Lock is off in all models. 

  
Figure 85 Turn on Graphic Group 

4.5.1 Manual Process 
On the CTDOT tab in the Sheet Production section select Borders > Replace with New 
Border. 

Set 
• Method: Replace 
• Mode: Single 
• The Use Active Cell will be toggled on with the cell name B-Contract active. 
• Annotation Scale will need to be on. 
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Follow the prompts to update the cell, when complete open the next model and repeat 

 
Figure 86 Replace Cell Tool 

4.5.2 Batch Process 

1. Open the DGN file with Sheet Models requiring and updated border cell. 

2. Open the Models dialog box. 

3. Select the Replace Cell tool. 
Set 
• Method: Update 
• Mode: Single 
• No Active Cell: 

 
Figure 87 Replace Cell dialog box 

1. Click to File > Tools > Batch Process 

2. Drag and drop the Sheet Models to the Batch Process, Process Tasks area. 

 
Figure 88 Drag in Sheet Models to batch Process 
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4. Click on … to load the Command File. 

 
Figure 89 Load Batch Command File 

5. Browse 
to CT_Configuration\Organization\Macros\CTDOT_Update_Border_Cell.txt and 
select Open. 

6. Select the Process Batch Process Job icon. 

 
Figure 90 Process Batch Process 

7. The Files to Process dialog box will open select Process to execute the commands. 
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Section 5 - Revisions 
10/28/2024 

Volume Section # Description  

1  
• Configurations, Seed Files and Converting have been moved to the 

Appendices. 
• Sections have been moved around to fit with the new format. 
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